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TERMS & CONDITIONS

Copyright © 2021 Technology Solutions (UK) Ltd. All rights reserved.

No part of this publication may be reproduced or used in any form, or by any electrical or mechanical means,
without permission in writing from Technology Solutions (UK) Ltd. This includes electronic or mechanical means,
such as photocopying, recording, or information storage and retrieval systems. The material in this manual is
subject to change without notice.

Technology Solutions (UK) Ltd (TSL) reserves the right to make changes to any product to improve reliability,
function, or design. TSL does not assume any product liability arising out of, or in connection with, the application
or use of any product, circuit, or application described herein. No license is granted, either expressly or by
implication, estoppel, or otherwise under any patent right or patent, covering or relating to any combination,
system, apparatus, machine, material, method, or process in which TSL products might be used. An implied
license exists only for equipment, circuits, and subsystems contained in TSL products. TSL and the TSL logo are
registered trademarks of TSL. Other product names mentioned in this manual may be trademarks or registered
trademarks of their respective companies and are hereby acknowledged.

All software is provided strictly on an “as is” basis. All software, including firmware, furnished to the user is on
a licensed basis. TSL grants to the user a non-transferable and non-exclusive license to use each software or
firmware program delivered hereunder (licensed program). Except as noted below, such license may not be
assigned, sublicensed, or otherwise transferred by the user without prior written consent of TSL. No right to
copy a licensed program in whole or in part is granted, except as permitted under copyright law. The user shall
not modify, merge, or incorporate any form or portion of a licensed program with other program material, create
a derivative work from a licensed program, or use a licensed program in a network without written permission
from TSL. The user agrees to maintain TSL’s copyright notice on the licensed programs delivered hereunder, and
to include the same on any authorized copies it makes, in whole or in part. The user agrees not to decompile,
disassemble, decode, or reverse engineer any licensed program delivered to the user or any portion thereof.
TSL reserves the right to make changes to any software or product to improve reliability, function, or design.
TSL does not assume any product liability arising out of, or in connection with, the application or use of any
product, circuit, or application described herein.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Technology Solutions (UK) Ltd is under license. Other trademarks and trade names are those of
their respective owners.
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MAIN PARTS OF THE HANDSCANNER

HANDSCANNER

The status LEDs on the top of the Handscanner provide an indication of the operating status of the unit.

LED Colour Status

Off The Handscanner is off.

Blue flashing The Handscanner is powered on and waiting for a 
Bluetooth® connection.

Continuous Blue The Handscanner is powered on and connected via 
Bluetooth®.

Red The Handscanner is charging.

Green The Handscanner is fully charged.

Red and Green The battery in the Handscanner has a fault, or it is 
being charged outside the recommended temperature 
range (0°C to 45°C).

Status LEDs

Trigger Button

Adjustable finger strap

Docking connector

Battery cover release.

WARNING

LASER LIGHT. 
DO NOT STARE INTO BEAM.
CLASS 2 LASER
PRODUCT.

LASERSTRAHLUNG
NICHT IN DEN STRAHL BLICKEN.
LASER KLASSE 2. 

LUMIÈRE
LASER NE PAS REGARDER
DANS LE FAISCEAU. APPAREIL
À LASER DE CLASSE 2. 

630-670nm 1mW

www.tsl.com
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The Charge Status LEDs indicate the state of the spare battery. The spare battery charge feature is independent of 
the charging of the battery inside the Handscanner.

LED Charge Status

Red on The spare battery is charging.

Green on The spare battery is fully charged.

Both red and green on. No spare battery is present, the spare battery has a 
fault, or the spare battery is being charged outside the 
recommended temperature range (0°C to 45°C).

MAIN PARTS OF THE HANDSCANNER

CRADLE

Charging slot for spare battery

Docking port for Handscanner

Charge Status LEDs

Communications port connector

Input from power supply

www.tsl.com
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USING THE HANDSCANNER

CHARGING THE HANDSCANNER
The Handscanner is charged by docking it in the cradle. Plug the power supply provided with the cradle in to 
the power in socket on the back of the cradle. The charge time will depend on how discharged the Handscanner 
battery is. Typically a fully discharged battery will take 3-4 hours to fully charge. The LEDs on the top of the 
Handscanner indicate the charge status; Red for charge in progress, Green for charge complete. Both LEDs on 
simultaneously indicates a fault condition. This will happen if the battery is outside the recommended charging 
temperature (0°C to 45°C), or if the battery has a fault.

The cradle is also capable of charging a spare battery at the same time as a Handscanner. The spare battery 
drops into the holder at the back of the cradle. The charge time in the cradle is the same as the Handscanner. 
Charge status is indicated by the LEDs on the cradle. Red indicates charge in progress, Green charge 
complete and Red and Green for fault (or battery not present). Note that the charge status of the spare battery is 
independent of the Handscanner.

REMOVING THE HANDSCANNER BATTERY

The battery can then be lifted out and replaced. Refit the cover by sliding it back up until the button clicks in place.

1) Press in the yellow button 2) Slide the battery cover down and lift it off.

www.tsl.com
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USING THE HANDSCANNER

HANDSCANNER READZONES

Both transponders and barcodes are read in front of the Handscanner as shown above. The barcode is read when 
the red laser line completely scans over it (1D) or it is enclosed in the projected red outline (2D). RFID transponders 
are read in the same plane as barcodes. The RFID read range is far less than the barcode. Typically an RFID 
device will be read at less than 10cm (dependent on the size and type of the RFID device). A barcode may be read 
between 5cm and 1m depending on the scanner type, barcode symbology, size and condition.

The Handscanner functionality depends on the software running on the host device. Generally pressing the button 
on the Handscanner triggers a barcode and/or RFID read. The RFID read zone is in front of the window on the 
Handscanner.

www.tsl.com
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USING THE HANDSCANNER

OPERATING MODES
The Handscanner has two fundamental operating modes; Host Command Mode and Button Press mode. Both 
modes may be combined in an actual deployed application.

Host Command Mode requires custom software to be developed and deployed to the host. All of the functionality 
and features of the Handscanner can be remotely controlled in Host Command Mode. The full command set 
is documented in the ‘Handscanner Programming Guide’. To simplify custom application development an API 
is available; this is documented in the ‘Handscanner API’ document. Both documents are available from the 
Technology Solutions’ website (www.tsl.uk.com/1062-downloads). Source code examples are provided in the 
Software Development Kit available from Technology Solutions (1062-0x-BT-HSCAN-KIT).

In Button Press Mode the Handscanner is initially configured to operate in a particular way each time the 
button is pressed. A PC application; Desktop Configuration is provided by Technology Solutions for configuring 
Handscanners. An overview of the configurable features is given in ‘Configurable features’.

Host Command Mode requires that the Handscanner has a Bluetooth® link to the host. Button Press Mode usually 
operates with a Bluetooth® link, but it is possible to configure the Handscanner to store scan data locally and 
download it later. This is Batch Mode and is described in ‘Batch mode’.

The method of establishing the Bluetooth® link varies between different host platforms. The Handscanner appears 
as a serial device (Bluetooth® Serial Port Profile) and so in some cases will be accessed over a virtual comm. 
port. The Handscanner establishes a secure Bluetooth® connection and therefore a PIN will be required during 
the pairing process. The default PIN is ‘0000’, but this can be changed using the Desktop Configuration software. 
When discovering devices the Bluetooth® Friendly Name of the Handscanner is set to be the same as the serial 
number printed on the side of the Handscanner. Again, this may be changed. Refer to the operating instructions of 
the host platform for further information on establishing a Bluetooth® link.

www.tsl.com
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USING THE HANDSCANNER

CONFIGURABLE FEATURES

The Desktop Configuration application supplied by Technology Solutions is required for configuring Button Press 
Mode on a Handscanner. This application is available for download from the Technology Solutions website (www.
tsl.uk.com/1062-downloads/) along with a full user guide. Configuration of the Handscanner is only possible over 
the wired serial connection. A cradle and serial data lead are therefore required. If the host PC does not have a 
serial port it is possible to use a USB to serial converter lead.

The following sections provide an overview of the configuration options.

INTRODUCTION

The Bluetooth® Friendly Name, the PIN and the Bluetooth® RF power can be modified.

BLUETOOTH® SETTINGS

The RFID functionality can be enabled and disabled for each transponder type. Barcode scanning, and the various 
symbologies included in a barcode scan can be enabled and disabled.

FUNCTIONALITY

A prefix can be added to the scanned data to indicate whether it came from a barcode, or from a particular RFID 
transponder type. A prefix can also be added to all scanned data to indicate which Handscanner the data came 
from.

PREFIX

The buzz on successful read function can be enabled or disabled.

BUZZER

Vibrate on successful read can be enabled or disabled.

VIBRATOR

An RFID transponder may contain multiple blocks of data in addition to the unique serial number. The start block 
and number of subsequent blocks to read when a transponder is present can be configured.

RFID MULTIBLOCK READ

Batch mode allows the Handscanner to store all scanned data locally if there is not a Bluetooth® link to the host. 
With Batch mode enabled the Handscanner continues to operate as normal, but stores scan data locally. This 
data can then be downloaded from the Handscanner memory subsequently. If Batch mode is not enabled the 
Handscanner will not respond to button presses when a Bluetooth® link is not established.

BATCH MODE

www.tsl.com
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USING THE HANDSCANNER

The maximum duration in seconds of a scan can be configured. The barcode reader has an independent maximum 
scan duration (4s for 1D, 10s for 2D). Setting the Scan Time to shorter than these times results in barcode and RFID 
scanning stopping at the specified time, setting the Scan Time to longer times results in the barcode scanning 
stopping before the RFID.

SCAN TIME

Batch mode is a useful feature in help to avoid data loss if the Bluetooth® link drops because the Handscanner 
has moved out of range of the host. There is a risk of a short period of data loss because the Bluetooth® link failure 
indication is not immediate. Scan data obtained during the period between moving out of range and the Bluetooth® 
link indicating failure may not be preserved.

The time in seconds that the Handscanner stays powered on after the Bluetooth® link has dropped or the button 
has been pressed can be changed from the default value of 120 seconds.

POWER DOWN TIME

The Desktop Configuration application includes a firmware loader for updating the Handscanner firmware.

FIRMWARE UPDATE

www.tsl.com
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APPLICATION EXAMPLES – PC

INTRODUCTION
These examples assume that the Handscanner is in its factory default state and that it is being used on a PC 
running Windows XP. The same approach can be taken with any other platform.

SETTING UP THE BLUETOOTH® CONNECTION
Establishing a Bluetooth® connection requires the stages of Discovery and Pairing. The Handscanner conforms to 
the Bluetooth® Serial Port Profile and therefore a Virtual Comm port will be created as part of the Bluetooth® setup 
process.

Launch the Bluetooth® Device window (Start>Control Panel>Bluetooth® Devices). Click the ‘Add’ button, switch on 
the Handscanner by pressing the yellow button. The Blue LED will start to flash slowly. Tick the ‘My device is set up 
and ready to be found.’ box and click the ‘Next’ button. This starts the Discovery process. When this is complete a 
list of devices will be shown, including the Handscanner as shown below:

The Handscanner will be identified by its Bluetooth® Friendly name which by default is the serial number printed on 
the side of the Handscanner. Click on the Handscanner and then on ‘Next’ to start Pairing. Enter the default PIN of 
‘0000’ as shown below and then click ‘Next’.

www.tsl.com
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The installation of the Handscanner will then continue. At this point the Virtual COM port will be created. When this 
has successfully completed the window shown below will be displayed.

Record the ‘Outgoing COM port’ number. This is the Virtual COM port that will be used by any application that 
needs to connect to the Handscanner.

APPLICATION EXAMPLES – PC www.tsl.com
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APPLICATION EXAMPLES – PC

USING SMARTWEDGE BASIC

SmartWedge Basic is an application for Windows XP which allows scanned data to be directly entered into another 
Application as though it had been typed on the keyboard. The data is inserted at the cursor of whichever window 
has focus. This allows the Handscanner to be immediately used in existing systems with no software development. 
The Handscanner can be configured (see “Configurable features” on page 10) to provide a certain set of 
actions on button press so that the correct data is read and prefixed ready for use by the existing software. A more 
advanced version of the SmartWedge software is available from Technology Solutions which includes additional 
functionality such as data filtering and formatting.

INTRODUCTION

SmartWedge Basic for the PC is provided in a standard Windows Installer (.msi) package. Double click to install the 
application.

INSTALLATION

Start SmartWedge from ‘Start > All Programs > Technology Solutions > SmartWedge Basic’. When the application 
starts it shows the configuration window as below:

OPERATION

Before using SmartWedge Basic the Handscanner must be associated with a virtual comm. port (see “Setting up 
the Bluetooth® connection” on page 36). Select the appropriate port number from the ‘COM Port selector’, ensure 
the Handscanner is powered on and tap the ‘Connect’ button. If the correct virtual comm. port is not shown in the 
‘COM Port selector’ then it is possible to directly type in the port number.

www.tsl.com
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Any RFID or barcode data scanned by the Handscanner will then appear at the top of the window and also in 
the ‘Default text window’ whilst SmartWedge Basic has focus (the cursor is flashing in the ‘Default text window’). 
Launch the application that is to receive the data, for example Excel, and position the cursor at the data entry point. 
Scan data will then be entered into the target application. By default all scanned data is terminated with CR LF 
characters to automate data entry. A typical screenshot is shown below:

Note that if CAPS lock is selected on the PC keyboard all of the alphabetical characters will have their case 
reversed so a lower case character from a barcode will appear as an upper case character in the receiving 
application and vice versa.

Minimise SmartWedge Basic using the cross in the top right hand corner of the window. SmartWedge Basic 
minimises to the System Tray. Hover the mouse over the icon to see the current status, double click to restore 
the main window or right click to restore, disconnect or exit the application. Even when SmartWedge Basic is 
minimised the ‘Most recent scan data’ entry is always updated with the most recently received text.
When SmartWedge Basic is no longer required, click ‘Disconnect’ to close the link to the Handscanner and exit 
SmartWedge Basic from ‘File > Exit’.

APPLICATION EXAMPLES – PC www.tsl.com
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APPLICATION EXAMPLES – PC

HYPERTERMINAL

HyperTerminal provides a simple way to display the data received from a Handscanner for demonstration or test 
purposes.

INTRODUCTION

Launch HyperTerminal from ‘Start > All Programs > Accessories > Communications > Hyperterminal.’ Name the 
new connection ‘Handscanner’ or something similar:

CONFIGURING HYPERTERMINAL

Click ‘OK’ and then chose the COM port that was displayed during the Bluetooth® setup (See “Setting up the 
Bluetooth® connection” on page 36):

www.tsl.com
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Check that the Handscanner is switched on, click ‘OK’ and the Bluetooth® connection will be established. Any 
barcodes or transponders read by the Handscanner will be displayed by HyperTerminal. Note that the virtual 
comm. port is opened at the default setting of 2400 baud. This does not affect performance because only small 
amounts of data are being transferred. It is possible to modify the baud rate and other connection settings by 
closing the connection and using ‘File>Properties’.

APPLICATION EXAMPLES – PC www.tsl.com
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APPLICATION EXAMPLES – POCKET PC

INTRODUCTION
These examples assume that the Handscanner is in its default state. Pocket PC devices have a range of different 
Bluetooth® Managers. The two examples provided should cover the majority of devices. The fundamental approach 
will be the same on all devices; discover the Handscanner and then pair to it. In most cases it will also be 
necessary to define a virtual comm. port for use with the Handscanner.

SETTING UP A BLUETOOTH® CONNECTION – SYMBOL MC70

The process of discovery and pairing can be performed directly using the Bluetooth® Manager on the host, 
BTExplorer. This method is described in ‘Using BTExplorer’. For many end users BTExplorer is over complex. 
Technology Solutions have developed a Pairing Wizard application available for free download from the website 
(www.tsl.uk.com/1062-downloads).

It is recommended that the Pairing Wizard should be used whenever possible. It provides a straightforward way of 
discovering Handscanners and then performs the pairing without further user interaction. The chosen Handscanner 
is set up for use on COM 4 ready for use by any application. Detailed instructions for installing and using the 
Bluetooth® Pairing Wizard are provided on the website.

A screenshot of the Pairing Wizard is shown below:

CONFIGURING HYPERTERMINAL

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

It is recommended that Technology Solutions’ Pairing Wizard application is used to set up the connection to the 
Handscanner whenever possible. This provides a simple user interface requiring minimal interaction. If special 
applications require the use of BTExplorer (the inbuilt Bluetooth® Manager) then this section provides instructions 
for using BTExplorer.

Ensure that Bluetooth® is enabled and start BTExplorer (Start>Programs>BTExplorer). If necessary tap 
‘View>Explorer Mode’ to exit the Wizard.

Tap ‘Tools>Discover Devices’ to start the Bluetooth® Discovery. The screen will look similar to the one below:

USING BTEXPLORER

Once the Bluetooth® Discovery is complete the Handscanner will appear in the Untrusted Devices list. The 
Handscanner will be identified by its Bluetooth® Friendly name which by default is the serial number printed on the 
side of the Handscanner:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Tap and hold the Handscanner and then select ‘Pair’ from the menu. Enter the default PIN of ‘0000’ and tap ‘OK’:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

The Pairing is then complete and the Handscanner will appear in the Trusted Devices list:

Tap and hold the Handscanner and select ‘Explore’ from the menu. An ‘AT serial’ port will be found:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Finally, tap and hold the Serial Port and select ‘Connect’. This will display the Connection Information as shown 
below. Note the Local COM Port. This is the port that an application will open to communicate with a Handscanner.

On the CN3 tap Start>Settings>Connections tab to get to the screen below:

Tap ‘Cancel’ and confirm that the connection should be cancelled then close BTExplorer.

SETTING UP A BLUETOOTH® CONNECTION – INTERMEC CN3

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Ensure that the Handscanner is powered up by pressing the yellow button. The blue LED will then be flashing.

Tap ‘Add new device…’ and the following screen will be shown:

Tap the Bluetooth® icon and then select the Devices tab:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

By default the Handscanner name corresponds to the serial number printed on the side of the unit. In this case it 
is’1062-01-BT-Hscan-000504’. Tap on the Handscanner and then on ‘Next’.

A Passcode will be requested, enter 0000.

Once the Device discovery has completed a list similar to the one shown below will be shown:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Finally tap on ‘Finish’ to complete the process.

Once the Handscanner is in the Known Devices List the display will be similar to the one below:

Once the authentication has completed successfully the following window will be shown, tap in the box next to 
serial port:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Tap on the Handscanner in the device list and tap ‘Next’:

If the application connecting to the Handscanner needs to use a Bluetooth® virtual comm port then select the ‘COM 
Ports’ tab and tap ‘New Outgoing Port’:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

The Handscanner will then be on the list of serial devices:

A list of the available ports will be displayed, select one and remember it. Tick the ‘Secure Connection’ box and tap 
‘Finish’.

Any application which opens this virtual comm. port (COM 4 in this example) will be connected to the 
Handscanner.

www.tsl.com
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USING SMARTWEDGE BASIC

SmartWedge Basic is a utility application for devices running Windows Mobile 5. An alternative version, 
SmartWedge CE is available for the Motorola WT4000 series of terminals. It captures any text received over a serial 
port and sends it to the active application as though it had been directly entered on the keyboard. This allows the 
Handscanner to be immediately used with existing applications. The Desktop Configuration application can be 
used to modify the Handscanner operation, for example by adding prefixes, excluding transponder types.

An advanced version of SmartWedge is available from Technology Solutions. This includes advanced data 
handling and filtering allowing rules to be constructed which modify the data processing based on the scanned 
data. It also integrates directly with the Bluetooth® stack on certain devices which simplifies operation.

INTRODUCTION

SmartWedge Basic is provided as a .cab file. ActiveSync to the target terminal and run the file to deploy 
SmartWedge Basic. The application note ‘Using the 1062 Handscanners with Motorola WT4000’ available on 
Technology Solutions’ website provides specific information for installing SmartWedge CE.

INSTALLATION

The SmartWedge Basic screen is shown below:

OPERATION

Before using SmartWedge Basic the Handscanner must be associated with a virtual comm. port (see “Setting 
up a Bluetooth® connection – Symbol MC70” on page 18 and “Setting up a Bluetooth® Connection – Intermec 
CN3” on page 22 for examples). Select the appropriate port number from the ‘COM Port selector’, ensure the 
Handscanner is powered on and tap the ‘Connect’ button.

APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Minimise SmartWedge Basic

Connect and Disconnect to serial port.

Close SmartWedge Basic

COM Port selector

Default text window

Most recent scan data

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Select the Handscanner and tap ‘Next’. The following window then opens:

The behaviour then depends on which Bluetooth® manager is used on the Pocket PC device. If BTExplorer rather 
than the Pairing Wizard is used on the MC70 the following window appears the first time that the virtual comm. port 
is opened:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Finally, tap ‘Connect’ to open the link with the Handscanner. For other devices, or if the Pairing Wizard application is 
used these intermediate stages may not be required and the virtual comm. port will be opened immediately. Once 
connected the button will change to show ‘Disconnect’ as above, and the blue LED on the Handscanner will light 
continuously.

Any RFID or barcode data scanned by the Handscanner will then appear at the top of the window and also in the 
‘Default text window’ whilst SmartWedge Basic is shown. Even when SmartWedge Basic is minimised the Most 
recent scan data entry is always updated with the most recently received text. Minimise SmartWedge Basic using 
the cross in the top right hand corner of the screen.

Open the application that is to receive the scan data, for example Pocket Excel and position the cursor at the data 
entry point. Scan data will then be entered into the target application. By default all scanned data is terminated with 
CR LF characters to automate data entry.

Note that if CAPS lock is selected on the terminal all of the alphabetical characters will have their case reversed 
so a lower case character from a barcode will appear as an upper case character in the receiving application and 
vice versa.

Tap ‘Next’ to see the following Connection Summary window:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

When SmartWedge Basic is no longer required switch back to it (Tap on the icon in ‘Programs’ or 
‘Settings>System>Memory>Running Programs’), tap ‘Disconnect’ to close the link to the Handscanner and exit 
SmartWedge Basic by tapping ‘Exit.’

If the terminal is put into Suspend state and then resumed the virtual comm. port is not reopened although 
SmartWedge Basic will still show ‘Disconnect’ as though the port was open. This is a limitation of Bluetooth® Virtual 
comm. ports. Tap ‘Disconnect’ and then ‘Connect’ to re-establish the link. The direct Bluetooth® Stack integration 
included in the advanced version of SmartWedge handles Bluetooth® connection recovery.

A typical screenshot is shown below:

www.tsl.com
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

USING MTOKEN

mToken is a Terminal Emulation application for Pocket PC devices. It is available for download from 
http://www.choung.net/mToken. A time limited evaluation version is also available.

INTRODUCTION

Connect to the Pocket PC device using ActiveSync and then run the mToken install. This will deploy the application 
to the device.

INSTALLATION

Launch mToken and tap ‘Session>Direct COM Port’. Select the COM port assigned during the Bluetooth® 
connection setup and a baud rate of 57600 as shown below:

Ensure that the Handscanner is powered on by pressing the yellow button and tap ‘Connect’. The behaviour then 
depends on which Bluetooth® manager is used on the Pocket PC device.

OPERATION
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Select the Handscanner and tap ‘Next’. The following window then opens:

If BTExplorer rather than the Pairing Wizard is used on the MC70 the following window appears the first time that 
the virtual comm. port is opened:
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Finally, tap ‘Connect’ to open the link with the Handscanner. For other devices these intermediate stages may 
not be required and the virtual comm. port will be opened immediately. Barcode and RFID data read by the 
Handscanner will then appear in the mToken window as shown below:

Tap ‘Next’ to see the following Connection Summary window:

The Handscanner is disconnected by tapping the Disconnect symbol in the bottom left hand corner of the screen.
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APPLICATION EXAMPLES – PCAPPLICATION EXAMPLES – POCKET PC

Tap on the stored entry and after a short delay with the window below shown the port will be opened:

Subsequent opens of the virtual comm. port are more straightforward on the MC70. Tap ‘Session’ and then the 
stored connection will be on the list:
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REGULATORY

All Technology Solutions devices are designed to be compliant with appropriate regulations and standards and 
are CE marked. Any changes or modifications to Technology Solutions equipment, not expressly approved by 
Technology Solutions, could void the user’s authority to operate the equipment.

SAFETY
The Handscanner complies with:

	● 21CFR1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated July 26, 2001.

	● EN60825-1:1994+ A1:2002 +A2:2001

	● IEC60825-1:1993+A1:1997+A2:2001

This information is repeated inside the battery compartment. The following Laser Warning Label is printed on the 
side of the Handscanner:

Caution: Use of controls, adjustments or performance of procedures other than those specified herein may result in 
hazardous laser light exposure.

Class 2 laser scanners use a low power, visible light diode. As with any very bright light source, such as the sun, 
the user should avoid staring directly into the light beam. Momentary exposure to a Class 2 laser is not known to be 
harmful.

The operation of wireless devices in an aircraft is forbidden or restricted in many cases. The Handscanner must not 
be operated in these situations.

The Handscanner transmits radio frequency energy and has the potential to interfere with inadequately protected 
medical devices. It is good practice to turn OFF the Handscanner within a hospital or other medical facility where 
sensitive medical equipment is in use. In some countries, this is a legal requirement applying to all mobile phones 
and related equipment.

WARNING

LASER LIGHT. 
DO NOT STARE INTO BEAM.
CLASS 2 LASER
PRODUCT.

LASERSTRAHLUNG
NICHT IN DEN STRAHL BLICKEN.
LASER KLASSE 2. 

LUMIÈRE
LASER NE PAS REGARDER
DANS LE FAISCEAU. APPAREIL
À LASER DE CLASSE 2. 

630-670nm 1mW
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FCC STATEMENT
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

1.	This device may not cause harmful interference, and
2.	this device must accept any interference received, including interference that may cause undesired 

operation.

The Handscanner contains Transmitter Module FCC ID: S6J01B

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one of the following measures:

	● Reorient or relocate the receiving antenna.

	● Increase the separation between the equipment and receiver.

	● Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

	● Consult the dealer or an experienced radio/TV technician for help.

BLUETOOTH®

The Handscanner contains an approved Bluetooth® Product, the Ezurio BISM2 Bluetooth® Serial Module.

APPLICATION EXAMPLES – PCREGULATORY

You should not use Handscanner at a refueling point. You are reminded of the need to observe restrictions on the 
use of radio devices in fuel depots, chemical plants etc. and areas where the air contains chemicals or particles 
(such as grain, dust, or metal powders) and any other area where you would normally be advised to turn off your 
vehicle engine.

Use only Technology Solutions approved cradles, chargers and power supplies with the Handscanner. Use of an 
alternative power supply will invalidate any approval given to this device, void the warranty for the product and may 
be dangerous.
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TROUBLESHOOTING

Symptoms Possible Cause Action

Nothing happens when the yellow 
button is pressed.

If no LEDs are on the battery may 
be flat.

Fit a fully charged battery, or charge 
the Handscanner.

The Handscanner may have been 
configured to exclude barcodes.

Check the Handscanner 
configuration using the Desktop 
Configuration software.

If the Blue LED is not lit continuously 
the Handscanner will only operate 
in Batch Mode.

Connect the Bluetooth® link to the 
Handscanner or use the Desktop 
Configuration software to enable 
Batch Mode.

The Handscanner scans but does 
not vibrate or beep.

The Handscanner may not be 
configured for the barcode 
symbology in use.

Check the Handscanner 
configuration using the Desktop 
Configuration software.

The vibrate and beep functions may 
have been disabled.

Check the Handscanner 
configuration using the Desktop 
Configuration software.

The barcode symbol may be 
damaged.

Try again with an undamaged 
barcode.

The Handscanner may not be at the 
correct distance from the barcode 
or transponder.

Change the distance or angle 
between the Handscanner and the 
barcode or transponder.

The battery may be low. Fit a fully charged battery, or charge 
the Handscanner.

The red and green LEDs light 
during charging.

The battery pack has a fault. Replace the battery pack.

The battery pack temperature is 
outside recommended limits.

Ensure that charging only occurs 
between 0°C and 45°C.

The host Bluetooth® discovery does 
not find the Handscanner

The Handscanner has powered off. Press the yellow button and ensure 
that the Blue LED is flashing.

The Handscanner is out of range. Move the Handscanner closer to 
the host.

The Bluetooth® Friendly name of the 
Handscanner has been changed.

Check the Bluetooth® Friendly name 
using the Desktop Configuration 
software.

Opening the Bluetooth® virtual 
comm. port does not connect to the 
Handscanner.

The host has paired to a different 
Handscanner.

Pair to the required Handscanner.

The host Bluetooth® function has an 
error.

Warm boot the host.
If this does not help, delete the 
Handscanner from the paired 
devices list and re-pair.

Bluetooth® pairing fails The PIN on the Handscanner has 
been changed.

Set the Bluetooth® PIN to a 
known value using the Desktop 
Configuration software.
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For EU Customers: All products at the end of their life must be returned to TSL for recycling. For information on
how to return product please contact TSL.

WARRANTY

WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT 
(WEEE)

(A) Warranty

TSL’s hardware Products are warranted against defects in workmanship and materials for a period of twelve (12) months 
from the date of shipment, unless otherwise provided by TSL in writing, provided the Product remains unmodified and is 
operated under normal and proper conditions. Warranty provisions and durations on software, integrated installed systems, 
Product modified or designed to meet specific customer specifications (“Custom Products”), remanufactured products, and 
reconditioned or upgraded products, shall be as provided in the applicable Product specification in effect at the time of 
purchase or in the accompanying software license. 

(B) Spare Parts

Spare parts (i.e. parts, components, or subassemblies sold by TSL for use in the service and maintenance of Products) are 
warranted against defects in workmanship and materials for a period of thirty (30) days from the date of shipment. Spare parts 
may be new or originate from returned units under the conditions set forth in subsection D below.

(C) Repair of TSL branded hardware 

For repairs on TSL branded hardware Products under this Agreement, including repairs covered by warranty, the repair services 
provided are warranted against defects in workmanship and materials on the repaired component of the Product for a period 
of thirty (30) days from the shipment date of the repaired Product, or until the end of the original warranty period, whichever is 
longer. Any such defects shall be notified to TSL in writing within 7 days of the same becoming apparent.

(D) Product Service 

Products may be serviced or manufactured with parts, components, or subassemblies that originate from returned products and 
that have been tested as meeting applicable specifications for equivalent new material and Products. The sole obligation of TSL 
for defective hardware Products is limited to repair or replacement (at TSL’s option) on a “return to base (RTB)” basis with prior 
TSL authorisation.

Customer is responsible for prompt shipment to TSL and assumes all costs and risks associated with this transportation; return 
shipment to the Customer will be at TSL’s expense. Customer shall be responsible for return shipment charges for product 
returned where TSL determines there is no defect (“No Defect Found”), or for product returned that TSL determines is not 
eligible for warranty repair. No charge will be made to Buyer for replacement parts for warranty repairs. TSL is not responsible 
for any damage to or loss of any software programs, data or removable data storage media, or the restoration or reinstallation of 
any software programs or data other than the software, if any, installed by TSL during manufacture of the Product.

(E) Original Warranty Period 

Except for the warranty applying solely to the repaired component arising from a repair service as provided in Section C above, 
the aforementioned provisions do not extend the original warranty period of any Product that had either been repaired or 
replaced by TSL. 
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(F) Warranty Provisions

The above warranty provisions shall not apply to any Product:
(i) which has been repaired, tampered with, altered or modified, except by TSL’s authorized service personnel; 
(ii) in which the defects or damage to the Product result from normal wear and tear, misuse, negligence, improper storage, water 
or other liquids, battery leakage, use of parts or accessories not approved or supplied by TSL, or failure to perform operator 
handling and scheduled maintenance instructions supplied by TSL;
(iii) which has been subjected to unusual physical or electrical stress, abuse, or accident, or forces or exposure beyond normal 
use within the specified operational and environmental parameters set forth in the applicable Product specification; nor shall the 
above warranty provisions apply to any expendable or consumable items, such as batteries, supplied with the Product.

EXCEPT FOR THE WARRANTY OF TITLE AND THE EXPRESS WARRANTIES STATED ABOVE, TSL DISCLAIMS ALL 
WARRANTIES ON PRODUCTS FURNISHED HEREUNDER INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR USE. ANY IMPLIED WARRANTIES THAT MAY BE IMPOSED BY LAW ARE LIMITED IN 
DURATION TO THE LIMITED WARRANTY PERIOD. SOME STATES OR COUNTRIES DO NOT ALLOW A LIMITATION ON 
HOW LONG AN IMPLIED WARRANTY LASTS OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OR CONSUMER PRODUCTS. IN SUCH STATES OR COUNTRIES, FOR SUCH PRODUCTS, SOME EXCLUSIONS OR 
LIMITATIONS OF THIS LIMITED WARRANTY MAY NOT APPLY. 

The stated express warranties are in lieu of all obligations or liabilities on the part of TSL for damages, including but not limited 
to, special, indirect or consequential damages arising out of or in connection with the use or performance of the Product or 
service. TSL’s liability for damages to Buyer or others resulting from the use of any Product or service furnished hereunder shall 
in no way exceed the purchase price of said Product or the fair market value of said service, except in instances of injury to 
persons or property.

TSL is not responsible for any damages incurred during shipment if the approved shipping container is not used. Shipping the 
units improperly can possibly void the warranty. If the original shipping container was not kept, contact your local distributor or 
TSL to have another sent to you.

TSL shall not be responsible for any injury, damage or loss of whatever kind caused directly or indirectly by the goods whether 
as a result of their manufacture, operation, use or otherwise and the customer shall indemnify TSL from any claim arising from 
any loss suffered by any third party.
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ABOUT

ABOUT TSL®

CONTACT

ISO 9001: 2015

Technology Solutions UK Ltd (TSL®), part of HID Global, is a leading manufacturer of high performance mobile 
RFID readers used to identify and track products, assets, data or personnel.
For over two decades, TSL® has delivered innovative data capture solutions to Fortune 500 companies around the 
world using a global network of distributors and system integrators.  Specialist in-house teams design all aspects of 
the finished products and software ecosystems, including electronics, firmware, application development tools, RF 
design and injection mould tooling.
TSL® is an ISO 9001:2015 certified company.

TECHNOLOGY
SOLUTIONSUK LTD

Address: Technology Solutions (UK) Ltd, Suite A, Loughborough Technology Centre, Epinal Way, 
Loughborough, Leicestershire, LE11 3GE, United Kingdom.

Telephone: +44 1509 238248
Fax: +44 1509 214144
Email: enquiries@tsl.com
Website: www.tsl.com

Technology Solutions (UK) Ltd reserves the right to change its products, specifications and services at any time without notice.

HID Global powers the trusted identities of the world’s people, places and things. We make it possible 
for people to transact safely, work productively and travel freely. Our trusted identity solutions give people 
convenient access to physical and digital places and connect things that can be identified, verified and tracked 
digitally. Millions of people around the world use HID products and services to navigate their everyday lives, and 
billions of things are connected through HID technology. We work with governments, educational institutions, 
hospitals, financial institutions, industrial businesses and some of the most innovative companies on the planet. 
Headquartered in Austin, Texas, HID Global has over 4,000 employees worldwide and operates international offices 
that support more than 100 countries. HID Global is an ASSA ABLOY Group brand.
For more information, visit www.hidglobal.com. 

ABOUT HID GLOBAL
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